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1. Πρόλογος 
Το MATLAB, έχει ονομαστεί από τις λέξεις MATrix LABoratory, και αποτελεί ένα λογισμικό 
περιβάλλον προγραμματισμού αριθμητικών μεθόδων, προσομοίωσης και γραφικής 
οπτικοποίησης. Το βασικό στοιχείο/ μεταβλητή του MATLAB είναι ο πίνακας και έτσι όλοι οι 
φιλόδοξοι μελλοντικοί προγραμματιστές πρέπει να γνωρίζουν τις βασικές μαθηματικές αρχές 
πινάκων και γραμμικής άλγεβρας. 

Το εγχειρίδιο αποσκοπεί να αποτελέσει ένα σύντομο βοήθημα αναφορικά με τις κυριότερες 
συναρτήσεις και δυνατότητες του MATLAB και του SIMULINK. Αν κάποιος θέλει να 
εμβαθύνει και να εκμεταλλευτεί όλες τις δυνατότητες που προσφέρει το λογισμικό μπορεί να 
χρησιμοποιήσει το User’s Manual ή την εντολή HELP η οποία θα αναλυθεί στο κεφάλαιο 3. 
Επίσης κάποιος μπορεί να χρησιμοποιήσει ένα από τα πάμπολλα FORUMS του διαδικτύου 
στα οποία μπορεί να βρει ειδικευμένες συναρτήσεις γραμμένες από άλλους χρήστες. Τέτοια 
FORUMS μπορούν να βρεθούν με ένα απλό search στο Google.  

Σημαντικό να αναφερθεί ότι το MATLAB έχει αναπτυχθεί για την πλατφόρμα Windows στην 
οποία το mouse είναι το κύριο μέσο επικοινωνίας. Πολλές από τις εντολές του MATLAB, 
μπορούν να γίνουν είτε μέσω του menu ή μέσω εντολών στο Command Prompt. Οι μέθοδοι 
αυτοί θα αναλυθούν και αφήνεται στις προτιμήσεις του χρήστη για το ποια μέθοδο θα 
χρησιμοποιεί. 

2. Εκκίνηση MATLAB 
Για την εκκίνηση του MATLAB/ SIMULINK απλά βρείτε ένα ελεύθερο υπολογιστή στο PC 
Lab και κάνετε Login με τους κωδικούς σας ή με τους ελεύθερους κωδικούς που 
προσφέρονται ( Username: temporal Password: !@#$% ( 12345) ). Tο λογισμικό 
βρίσκετε στο Start Menu των Windows μέσα στο αρχείο MATH. 

3. Η Εντολή HELP 
Ο ευκολότερος τρόπος για να βρει κάποιος βοήθεια για κάποια διεργασία που τον 
ενδιαφέρει είναι μέσω της εντολής HELP την οποία μπορεί να πληκτρολογήσει στο 
Command Prompt ή να κάνει click στο Help που βρίσκετε στο menu πάνω δεξιά και μετά 
στο Product Help. Ποιο κάτω φαίνεται η διαδικασία: 

 

Θα εμφανιστεί ένα παράθυρο με όλα τα Toolboxes που υποστηρίζει το λογισμικό και 
εξερευνώντας τα, κάποιος μπορεί να βρει επεξηγήσεις για τις συναρτήσεις που τον 
ενδιαφέρουν μαζί με παραδείγματα εφαρμογής τους. 
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Ο ευκολότερος τρόπος για να βρει κάποιος την συνάρτηση που τον ενδιαφέρει είναι μέσω 
μιας απλής αναζήτησης με λέξεις κλειδιά για την σχετική συνάρτηση στο Product Help. 

 

Στη συνέχεια φαίνεται η μορφή του περιβάλλοντος για την συνάρτηση ημιτόνου (sin): 

 

 

Για έξοδο από το HELP κάποιος απλά πρέπει να κλείσει το παράθυρο του Product Help 
. Αν κάποιος θέλει άμεση πρόσβαση στις βιβλιοθήκες στήριξης του MATLAB χωρίς 
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να ανοίξει ξεχωριστό παράθυρο το μόνο που χρειάζεται να κάνει είναι να πληκτρολογήσει 
help στο Command Prompt: 

 

Κάνοντας click στην οικογένεια συναρτήσεων που χρειάζεται να χρησιμοποιηθεί π.χ.: 
matlab\matfun μας δίνονται όλες οι συναρτήσεις: 

 

Εναλλακτικά μπορεί κάποιος να γράψει απευθείας στο Command Prompt "help" -κενό- 
όνομα συνάρτησης και να βγει μία σύντομη περιγραφή της. Επίσης πρέπει να αναφερθεί ότι 
με την εντολή help παρέχεται μια σύντομη περιγραφή της συνάρτησης και του τρόπου 
λειτουργίας της (που πολύ συχνά είναι αρκετή). Για μια πιο αναλυτική περιγραφή, πρέπει 
κανείς να πάει μέσω του Help Menu, που περιγράφτηκε πιο πάνω. 
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4. Διαχείριση Workspace 
Υπάρχουν τέσσερις τρόποι για έξοδο από το MATLAB. Πληκτρολογώντας quit: 

 

ή exit: 

 

στο command prompt και πατώντας μετά το κουμπί enter 

ή κάνοντας click στο File και μετά στο Exit MATLAB: 

 

ή τέλος απλά κλείνοντας το παράθυρο από το .  

Πριν την έξοδο από το MATLAB καλή πρακτική είναι να γίνεται save το workspace για 
μελλοντική χρήση. Κάνουμε click στο File και μετά στο Save Workspace As... 
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και στην συνέχεια επιλέγουμε την τοποθεσία προτίμησης. Η επιλογή μπορεί να γίνει 
κάνοντας click στο βελάκι δίπλα από το Save in: 

 

μέχρι να δούμε την τοποθεσία που θέλουμε και επιλέγοντας την. Ακολούθως 
πληκτρολογούμε την ονομασία του αρχείου στο σημείο File name. 

 

Τέλος κάνουμε click στο Save. Για να επαναφέρουμε το workspace πληκτρολογούμε load 
τοποθεσία g ή f:\όνομα_αρχείου χωρίς το extension .mat και πατάμε enter. 

 

5. Πίνακες στο MATLAB 
Η απλούστερη μέθοδος για να εισαγάγει κάποιος ένα πίνακα φαίνεται ποιο κάτω όπου τα 
στοιχεία ενός πίνακα μπαίνουν ανάμεσα σε αγκύλες, τα στοιχεία μιας γραμμής 
χωρίζονται από κενό, ενώ οι γραμμές μεταξύ τους χωρίζονται με ";", όπως φαίνεται 
στο σχήμα: 

 

Ισοδύναμα κάποιος μπορούσε να έχει το ίδιο αποτέλεσμα πληκτρολογώντας τα ποιο κάτω 
όπου η αλλαγή γραμμής γίνετε με και Enter: 
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Το ποιο πάνω παράδειγμα θέλει να τονίσει ότι τα στοιχεία του πίνακα μπορούν να είναι 
μιγαδικά ή πραγματικά καθώς και με συναρτήσεις όπως η sqrt(2) (sqrt(2) = 2  ) ή και με 

πράξεις 
7 − 2( )× 4
5

+ 3 . 

Οι συντεταγμένες των πινάκων, των βαθμωτών τους στοιχείων (1x1) και των διανυσμάτων 
(1 x n ή m x 1), δίνονται ποιο κάτω: 

 

 

1,1 1,2 1,n

2,1 2,2 2,n

m,1 m,2 m,n

⎡

⎣

⎢
⎢
⎢
⎢

⎤

⎦

⎥
⎥
⎥
⎥

 

 

Αν θέλουμε έτσι να απομονώσουμε το στοιχείο (2,3) του πίνακα A, πληκτρολογούμε: 

 

Αν είχαμε δύο διανύσματα V = 1 −6 7 9E2 22⎡⎣ ⎤⎦  (διάνυσμα-γραμμής) και
W = 1 2 3 4e3 0⎡⎣ ⎤⎦ (διάνυσμα-στήλης) με την χρήση του ";" να είναι η κύρια 
διαφορά. 

 

τότε πληκτρολογούμε: 
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Για να απομονώσουμε το τέταρτο στοιχείο κάθε διανύσματος.  

Για διανύσματα με μορφή σειράς αρκετό είναι να δώσουμε την στήλη που βρίσκετε το 
στοιχείο. Με τον ίδιο τρόπο για διανύσματα με μορφή στήλης αρκετό είναι να δώσουμε την 
σειρά του στοιχείου. Στο ποιο πάνω παράδειγμα, V(4)=V(1,4) και W(4)=W(4,1). 

Επίσης είναι δυνατός ο ορισμός μιας ακολουθίας στοιχείων χρησιμοποιώντας την άνω και 
κάτω τελεία (:). Για παράδειγμα: 

 

Επίσης μπορούμε να ρυθμίσουμε το βήμα μεταβολής της ακολουθίας από 1 σε 0.5 ως 
ακολούθως: 

 

Έτσι αν θέλουμε η μεταβλητή Ε να έχει τις σειρές 2 και 3 του πίνακα Α τότε πληκτρολογήστε: 

 

Έτσι ένας πίνακας μπορεί να κατασκευαστεί από στοιχεία άλλων πινάκων καθώς και από 
άλλους πίνακες που είναι ήδη προγραμματισμένοι στις βιβλιοθήκες του MATLAB: 

Προγραμματισμένοι Πίνακες 
zeros 
ones 
rand 
eye 

Πίνακας με μηδενικά στοιχεία 
Πίνακας με όλα τα στοιχεία 1 
Πίνακας με τυχαία στοιχεία 
Ταυτοτικός πίνακας 

 

Για παράδειγμα: 
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Πολύ συχνά είναι χρήσιμο να μάθουμε την διάσταση (m x n) ενός πίνακα. Η συνάρτηση size 
επιστρέφει ένα διάνυσμα διάστασης 1x2 με τον αριθμό των σειρών m και των στηλών n του 
πίνακα. Πληκτρολογώντας έτσι: 

 

Μια γενικότερη μέθοδος αναγνώρισης/ διαχωρισμού δυο ή περισσότερων αποτελεσμάτων 
από μια συνάρτηση είναι ο ορισμός ίσου αριθμού μεταβλητών με κενό μεταξύ τους μέσα σε 
αγκύλες ([ ]). Για παράδειγμα: 

 

Κάποιες χρήσιμες συναρτήσεις όταν διαχειριζόμαστε πίνακες δίνονται στον πιο κάτω 
πίνακα: 

Συναρτήσεις Στατιστικής 
max 
min 
mean 
std 
sum 
prod 

Μέγιστη τιμή 
Ελάχιστη τιμή 
Μέση τιμή 
Τυπική απόκλιση 
Άθροισμα στοιχείων 
Γινόμενο στοιχείων 

Αν κάποιος θέλει περισσότερες πληροφορίες για τις ποιο πάνω συναρτήσεις μπορεί να 
χρησιμοποιήσει την εντολή HELP. 

6. Πράξεις Πινάκων 
Βασική αριθμητική/ πράξεις πινάκων γίνονται με μεγάλη ευκολία στο MATLAB και κάποιες 
από τις βασικότερες πράξεις συνοψίζονται ποιο κάτω: 

Πράξεις Πινάκων 
+ 
- 
* 
/ 
\ 

Πρόσθεση 
Αφαίρεση 
Πολλαπλασιασμός 
Διαίρεση από δεξιά 
Διαίρεση από αριστερά 
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^ 
’ 
det 
inv 
eig 

Εκθετική Δύναμη 
Ανάστροφο-συζυγής 
Ορίζουσα 
Αντίστροφος 
Ιδιοτιμές/ ιδιοδιανύσματα 

Πρέπει να σημειωθεί ότι οι μαθηματικοί κανόνες που διέπουν τις πράξεις μεταξύ πινάκων 
ισχύουν και στο ΜΑTLAB. Για παράδειγμα η πρόσθεση/ αφαίρεση είναι δυνατή μόνο όταν οι 
πίνακες έχουν τις ίδιες διαστάσεις ενώ για πολλαπλασιασμό πινάκων οι εσωτερικές 
διαστάσεις των πινάκων πρέπει να είναι ίδιες. Επιπρόσθετα για την δεξιά ή αριστερή 
διαίρεση η μέθοδος χρήσης των τελεστών γίνετε ως εξής: 

Z = X\Y που είναι ισοδύναμο με Z = inv(X)*Y 

Z = X/Y που είναι ισοδύναμο με Z = X*inv(Y).  

Η εντολή, A^2 είναι ταυτόσημη με την A*A όπου είναι αυτονόητο ότι ο πίνακας A πρέπει να 
είναι τετράγωνος. Η πράξη 2^A είναι επίσης δυνατή χρησιμοποιώντας ιδιοτιμές και 
ιδιοδιανύσματα. Τέλος ο ερμιτιανός (ανάστροφο-συζυγής πίνακας) υπολογίζετε από την 
απόστροφο (’) ενώ οι συναρτήσεις det, inv, και eig έχουν προφανείς λειτουργίες (για 
λεπτομερέστερη εξήγηση των συναρτήσεων χρησιμοποιήστε την εντολή HELP για την 
μέθοδο εφαρμογής τους).  

7. Μαθηματικές πράξεις με διανύσματα 
Αριθμητικές πράξεις στοιχείο - ανά - στοιχείο είναι δυνατές τοποθετώντας τελεία (.) μπροστά 
από την επιθυμητή μαθηματική πράξη όπως φαίνεται ποιο κάτω: 

Πράξεις Διανυσμάτων 
+ 
- 
.* 
./ 
.\ 
.^ 
.’ 

Πρόσθεση 
Αφαίρεση 
Βαθμωτός πολλαπλασιασμός 
Διαίρεση από δεξιά 
Διαίρεση από αριστερά 
Εκθετική Δύναμη 
Ανάστροφος 

Παραδείγματα των ποιο πάνω πράξεων δίνονται ποιο κάτω: 

Πρόσθεση Διανυσμάτων: 

 

Αφαίρεση Διανυσμάτων: 
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Βαθμωτός πολλαπλασιασμός Διανυσμάτων: 

 

Διαίρεση από δεξιά 

 

Διαίρεση από αριστερά 

 

Εκθετική Δύναμη 

 

 

Σημαντικό να παρατηρηθεί ότι το ερωτηματικό (;) στο τέλος μιας εντολής δεν εμφανίζει το 
αποτέλεσμα/ έξοδο στο Command Prompt. Πιο κάτω συνοψίζονται βασικές συναρτήσεις. 
Αφήνεται στον αναγνώστη να μάθει πως να τις εφαρμόσει (π.χ. Help atan2): 
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Τριγωνομετρικές Συναρτήσεις Βασικές Μαθηματικές Συναρτήσεις 
sin 
cos 
tan 
asin 
acos 
atan 
atan2 
sinh 
cosh 
tanh 
asinh 
acosh 
atanh 
 

Ημίτονο 
Συνημίτονο 
Εφαπτόμενη 
Τόξο ημιτόνου 
Τόξο συνημίτονου 
Τόξο εφαπτομένης 
Four quadrant arctangent 
Υπερβολικό ημίτονο 
Υπερβολικό συνημίτονο 
Υπερβολική εφαπτομένη 
Υπερβολικό τόξο ημίτονου  
Υπερβολικό τόξο 
συνημίτονου  
Υπερβολικό τόξο 
εφαπτομένης 

abs  
angle 
sqrt 
real 
imag 
conj 
round 
fix 
floor 
ceil 
sign 
rem 
exp 
log 
log10 

Απόλυτη τιμή ή πλάτος μιγαδικού 
Γωνία φάσης 
Τετραγωνική ρίζα 
Πραγματικό μέρος 
Φανταστικό μέρος 
Συζυγής Μιγαδικός 
Στρογγυλ. πλησιέστερο ακέραιο  
Στρογγυλοποίηση προς το μηδέν 
Στρογγυλοποίηση προς -∞ 
Στρογγυλοποίηση προς +∞ 
Επιστρέφει το πρόσημο μιας τιμής 
Επιστρέφει το υπόλοιπο 
Εκθετική ύψωση 
Φυσικός λογάριθμος 
Λογάριθμος με βάση 10 

8. Γραφικές Παραστάσεις 
Ένας από τους κύριους λόγους της ευρείας χρήσης του MATLAB είναι η δυνατότητα 
οπτικοποίησης δεδομένων υπό την μορφή δισδιάστατων και τρισδιάστατων γραφικών 
παραστάσεων. Τα δεδομένα που προκύπτουν από τους αριθμητικούς υπολογισμούς, τα 
πειράματα και τις προσομοιώσεις μπορούν να επεξεργαστούν εύκολα και να 
οπτικοποιηθούν με την μορφή δισδιάστατων/ τρισδιάστατων γραφικών παραστάσεων. 
Μερικές από τις ποιο διαδεδομένες εντολές οπτικοποίησης του MATLAB δίνονται πιο κάτω: 

 

Εντολές Οπτικοποίησης 
plot 
loglog 
semilogx 
semilogy 
polar 
mesh 
contour 
bar 
stairs 

Δισδιάστατη γραφική παράσταση 
Λογαριθμική γραφική παράσταση 
Λογαριθμικός άξονας x, γραμμικός άξονας y 
Λογαριθμικός άξονας y, γραμμικός άξονας x 
Πολική γραφική παράσταση 
3-D γραφική πλέγματος 
Ισοϋψής γραφική παράσταση 
Γραφική παράσταση στηλών 
Διακριτή γραφική παράσταση 

Η εντολή plot είναι η ποιο πολύ χρησιμοποιημένη εντολή οπτικοποίησης με τις εντολές 
loglog, semilogx, semilogy, και polar να χρησιμοποιούνται με τον ίδιο τρόπο. Παραδείγματος 
χάριν οι εντολές, 

 

 

Παράγουν την δισδιάστατη γραφική όπου τα στοιχεία του διανύσματος b τυπώνονται 
συναρτήσει των στοιχείων του διανύσματος a. 
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Επιπρόσθετα διανύσματα μπορούν να τυπωθούν στην ίδια γραφική όπως φαίνεται ποιο 
κάτω: 

 

Με έξοδο στην γραφική: 

 

Αν η εντολή plot καλείτε με μια μόνο μεταβλητή τότε τα στοιχεία του διανύσματος 
εκτυπώνονται συναρτήσει των συντεταγμένων θέσης τους στον πίνακα ή στο διάνυσμα. Το 
MATLAB δίνει την δυνατότητα ρυθμίσεων στον τρόπο οπτικοποίησης των δεδομένων όπως 
αλλαγή του τύπου γραμμής, ρύθμιση χρωμάτων, τιτλοδότηση αξόνων έτσι ώστε ο χρήστης 
να μπορεί με ευκολία και αποτελεσματικότητα να αναλύει διάφορα δεδομένα. 

Μερικές από τις γραφικές ρυθμίσεις συνοψίζονται στον πίνακα πιο κάτω: 
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Τύπος Γραμμής Χρώμα 
. 
o 
x 
+ 
* 
- 
: 
-. 
-- 

Σημείο 
Κύκλος 
Τύπου Χ 
Σταυροειδής 
Αστεράκι 
Συνεχής 
Διακεκομμένη 
Συνεχής με τελεία 
Συνεχής με κενό 

y 
g 
c 
r 
m 
b 
w 
k 
 

Κίτρινο 
Πράσινο 
Κυανό 
Κόκκινο 
Μοβ 
Μπλε 
Άσπρο 
Μαύρο 
 

 

Η μέθοδος εκτέλεσης της εντολής δίνετε από: plot(vector1,vector2,’line-type’) 

 

Με έξοδο στην γραφική: 

 

Οι εντολές ταυτοποίησης μιας γραφικής παράστασης δίνονται πιο κάτω: 

Τιτλοδότηση Γραφικής 
title 
xlabel 
ylabel 
text 
gtext 
grid 

Τίτλος 
Ονομασία άξονα x 
Ονομασία άξονα y 
Κείμενο στην γραφική 
Κείμενο με ρυθμισμένη θέση 
Πλέγμα 

 

Η μέθοδος εφαρμογής τους είναι αρκετά απλή, για παράδειγμα: 
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Με έξοδο στη γραφική: 

 

Συχνά είναι αναγκαία η οπτικοποίηση πολλών γραφικών σε ένα φύλλο. Η εντολή που διαιρεί 
την γραφική παράσταση σε 'υπό-γραφικές' παραστάσεις είναι η subplot. Ο τρόπος 
εφαρμογής της εντολής δίνεται ως εξής: subplot(mnr). Όπου, m είναι ο αριθμός των σειρών 
και n είναι ο αριθμός των στηλών που θέλουμε να διαιρέσουμε την γραφική παράσταση. Η 
μεταβλητή r αναφέρετε σε ποιο παράθυρο θέλουμε να εμφανίσουμε τα δεδομένα. Για 
παράδειγμα οι ποιο κάτω εντολές μας δίνουν τα ακόλουθα αποτελέσματα: 

 

0 1 2 3 4 5 6 7 8 9 10
-1

-0.8

-0.6

-0.4

-0.2

0

0.2

0.4

0.6

0.8

1

x-axis in radians

y-
ax

is

Graph of sin(a) in stars and cos(a) in circles



 17

 

 

Με έξοδο στην γραφική: 

 

Επιπρόσθετα αν είναι επιθυμητή η αλλαγή της κλίμακας των αξόνων για καλύτερη 
παρουσίαση των δεδομένων πληκτρολογώντας: axis([x-min x-max y-min y-max]). Όπου, x-
min και x-max είναι οι ελάχιστες και μέγιστες τιμές του άξονα μας και οι y-min και y-max 
αντίστοιχα για τον κατακόρυφο άξονα. 

Για την εκτύπωση μίας γραφικής, από το παράθυρο της γραφικής επιλέξετε File→ Print→ 
OK. 
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9. Εντολές Workspace 
Ακολουθεί μια λίστα χρήσιμων εντολών που περιέχονται στο MATLAB και δεν έχουν 
προαναφερθεί: 

Εντολές Workspace 
who 
whos 
what 
clc 
clear 
clear μεταβλητή 
format 
... 
hold 
delete 
<Ctrl>-C 
<Esc> 
<Home> 
<End> 

Λίστα αποθηκευμένων μεταβλητών 
Σαν την who με περισσότερες πληροφορίες 
Λίστα αρχείων τύπου .M που χρησιμοποιούνται 
Καθαρίζει την οθόνη εντολών 
Καθαρίζει όλες τις μεταβλητές από την μνήμη 
Καθαρίζει την μεταβλητή από την μνήμη 
Αλλάζει τον τρόπο εμφάνισης αριθμητικών δεδομένων 
Δηλώνει ότι η εντολή συνεχίζεται στην επομένη γραμμή 
Διατηρεί την γραφική στην οθόνη 
Διαγραφή αρχείου 
Τοπική ακύρωση κώδικα που τρέχει 
Διαγράφει μια γραμμή εισόδου 
Μετακινεί τον δρομέα στην αρχή μιας γραμμής 
Μετακινεί τον δρομέα στο τέλος μιας γραμμής 

 

Στο Matlab, οι μεταβλητές Z και z (κεφαλαία-πεζά) είναι διαφορετικές. 
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10. Πολυωνυμικές Πράξεις 
Στο MATLAB τα πολυώνυμα συμβολίζονται με ένα διάνυσμα σειράς. Για ένα πολυώνυμο 
νιοστής τάξης το MATLAB χρειάζεται ένα διάνυσμα σειράς μήκους ν+1. Αν θέλουμε να 
εκφράσουμε το πολυώνυμο y=x3+5x-1 σαν διάνυσμα σειράς τότε απλά δίνουμε την εντολή 
y=[1 0 5 -1]. Σημαντικό ότι οι συντελεστές της μεταβλητής x έχουν εισαχθεί στο διάνυσμα y 
έτσι το “0” σημαίνει ότι ο όρος “x2” έχει μηδενικό συντελεστή.  

Το MATLAB προσφέρει πολύ χρήσιμες εντολές διαχείρισης πολυωνύμων οι οποίες δίνονται 
στον επόμενο πίνακα: 

 

Πολυωνυμικές Πράξεις 
roots 
poly 
polyval 
conv 
deconv 

Ρίζες του πολυώνυμου 
Χαρακτηριστικό πολυώνυμο 
Υπολογισμός τιμής συναρτήσει μεταβλητής 
Συνέλιξη πολυωνύμου 
Αποσυνέλιξη πολυωνύμου μέσω διαίρεσης 

 

Για παράδειγμα: 

 

Στο ποιο πάνω παράδειγμα οι ρίζες του y έχουν υπολογιστεί και αποθηκευτεί στο διάνυσμα 
r. Επιπρόσθετα πληκτρολογώντας poly(r) οι αρχικοί συντελεστές του y έχουν επιστραφεί. 
Τέλος το πολυώνυμο υπολογίστηκε στο x=-2 μέσω της συνάρτησης polyval. 

Αν υπήρχε και δεύτερο πολυώνυμο π.χ. w=2x
2
-x-1, τότε το αντίστοιχο διάνυσμα που το 

ορίζει δίνετε από w=[2 -1 -1] και θα μπορούσαμε να κάνουμε τα ακόλουθα: 
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Έτσι η συνέλιξη των w και y μας επιστρέφει z=2x5-x4+9x3-7x2-4x+1 και η αποσυνέλιξη των z 
με w επιστρέφει τους συντελεστές του y χωρίς υπόλοιπα. 

11. Λογικοί Τελεστές 
Το MATLAB είναι εξοπλισμένο με τρεις λογικούς τελεστές οι οποίοι φαίνονται στον πίνακα 
κάτω και δρουν ανά στοιχείο σε ένα πίνακα. Το MATLAB είναι προγραμματισμένο να θεωρεί 
οποιαδήποτε μεταβλητή με μη-μηδενικό πραγματικό μέρος σαν ΑΛΗΘΗ-TRUE και 
επιστρέφει την τιμή “1” ενώ όλες οι άλλες περιπτώσεις θεωρούνται ΑΝΑΛΗΘΕΊΣ-FALSE και 
η αξία “0” επιστρέφεται. 

Λογικοί Τελεστές 
& 
| 
~ 

Και 
Ή 
Όχι/Δεν 

Οι τελεστές & και | μπορούν να συγκρίνουν δύο αριθμούς ή δυο πίνακες ίσων διαστάσεων. 
Ο τελεστής ~ επιδρά μόνο σε μία μεταβλητή. 

Για παράδειγμα: 
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Συγκρίσεις μεταξύ πινάκων μπορεί να γίνει μέσω των τελεστών που φαίνονται στον ποιο 
κάτω πίνακα και στα παραδείγματα: 

Τελεστές Σύγκρισης 
< 
<= 
> 
>= 
== 
~= 

Λιγότερο από 
Λιγότερο ή ίσο 
Μεγαλύτερο από 
Μεγαλύτερο ή ίσο 
Ίσο 
Άνισο 

 

 

Δύο συναρτήσεις που χρησιμοποιούνται συχνά μαζί με λογικούς τελεστές είναι οι any και all. 
Πληκτρολογώντας any(A,i), η τιμή “1” θα επιστραφεί αν το πραγματικό μέρος οποιουδήποτε 
στοιχείου του Α είναι μη-μηδενικό για την δοθείσα διάσταση i. Αν το A είναι διάνυσμα τότε ο 
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ορισμός της διάστασης παραλείπετε. Η συνάρτηση all δουλεύει με τον ίδιο τρόπο με την 
διαφορά ότι όλα τα στοιχεία πρέπει να είναι μη-μηδενικά για να επιστραφεί η αξία “1”. 

12. Έλεγχος Ροής 
Το MATLAB έχει αρκετές εντολές έλεγχου ροής παρόμοιες με αυτές που χρησιμοποιούνται 
στις περισσότερες προγραμματιστικές γλώσσες. Οι εντολές αυτές μας δίνουν την 
δυνατότητα να δημιουργήσουμε ειδικευμένα προγράμματα για την εφαρμογή που χρειάζεται. 
Οι εντολές FOR, WHILE, IF, και IF-ELSE θα εξηγηθούν ποιο κάτω μέσω παραδειγμάτων: 

 

Επαναληπτική εντολή 
FOR 

 
for v = expression 
statements 
end 

Εφαρμογή εντολής for: 

 

Η εντολή for δίνει αρχική αξία στην μεταβλητή i. Ακολούθως εκτελεί τις μαθηματικές 
εξισώσεις ορίζοντας τις τιμές των διανυσμάτων S(i) και Τ(i) βάση των εξισώσεων. 
Ακολούθως ανανεώνετε η αξία της μεταβλητής i κατά 1 και επαναλαμβάνονται οι 
υπολογισμοί. Η ποιο πάνω διαδικασία επαναλαμβάνετε μέχρι η μεταβλητή i να πάρει την 
τελική τις τιμή που ισούται με 3 στην περίπτωση μας. 

 

Επαναληπτική εντολή 
WHILE 

 
while expression 
 
statements 
 
end 
 

Η εντολή while εκτελεί τον εσωτερικό βρόγχο επαναληπτικά όσο η συνθήκη που έχει οριστεί 
ικανοποιείται. 

Εφαρμογή εντολής while: 



 23

 

Επαναληπτική εντολή 
IF 

 
if expression 
 
statements 
 
end 

 

Η εντολή if εκτελεί τον εσωτερικό βρόγχο μια φορά αν η συνθήκη που έχει οριστεί 
ικανοποιείται. Εφαρμογή εντολής if: 

 

 

 

Επαναληπτική εντολή IF-
ELSE 

 
if expression 
 
statements 
 
else 
 
statements 
 
end 

Η εντολή if-else ελέγχει αν η συνθήκη που έχει οριστεί ισχύει. Αν ισχύει εκτελεί τον πρώτο 
βρόγχο. Αν δεν ισχύει εκτελεί τον δεύτερο. Σημαντικό ότι μπορούμε να έχουμε όσους 
βρόγχους θέλουμε που λειτουργούν με την ίδια λογική. 

Εφαρμογή εντολής if-else: 
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Η εντολή if else αποτελείται από δυο βρόγχους και η δυνατότητα εκτέλεσης του κάθε 
βρόγχου εξαρτάται εάν η συνθήκη εισόδου στον βρόγχο ικανοποιείται. Στην περίπτωση μας 
η αξία της μεταβλητής g ορίζει ποιος βρόγχος θα εκτελεστεί.  

13. Συναρτήσεις .m 
Το MATLAB επιτρέπει την δημιουργία από τον χρήστη συναρτήσεων μέσω των αρχείων .m. 
Για να γράψουμε ένα αρχείο .m κάνουμε click στο File μετά στο New και μετά στο Script: 

 

Ακολούθως ανοίγει το παράθυρο εργασίας όπου ο χρήστης μπορεί να βάλει τον κώδικα του. 

 

Όταν ο χρήστης επιθυμεί να κάνει save τότε απλά πηγαίνει στο File → Save As 

 

και μετά μπορεί να ονομάσει το αρχείο .m. 
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Όταν δημιουργείτε ένα αρχείο .m η πρώτη γραμμή πρέπει να ξεκινά με την εντολή function 
με την γενική μορφή να δίνετε ως: 

function [output1, ...] = όνομα συνάρτησης (μεταβλητή1, μεταβλητή2, etc.) εάν η συνάρτηση 
έχει εξόδους ή function όνομα συνάρτησης (μεταβλητή1, μεταβλητή2, etc.) εάν δεν έχει. Οι 
μεταβλητές "μεταβλητή1" κ.λπ. αποτελούν τις εισόδους της συνάρτησης. Η συνάρτηση 
πρέπει να σώζεται ακριβώς με το "όνομα συνάρτησης" που φαίνεται στην πρώτη γραμμή 
της. 

 

Για παράδειγμα: 

η συνάρτηση που περιγράφει το αρχείο .m ονομάζεται witch.m και καλείται ως εξής: 

Και έχει ως έξοδο την: 
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Όπου το σύμβολο (%) χρησιμοποιείται για τον ορισμό σχόλιου αναφορικά με τον κώδικα και 
έτσι το compiler ξέρει να το αγνοήσει. Αν κάποιος δοκιμάσει να βάλει την εντολή help witch, 
τότε θα πάρει απλά τα σχόλια της πρώτης γραμμής: 

14. Εφαρμογές Matlab στον Αυτόματο Έλεγχο 
Στην θεωρία του αυτομάτου ελέγχου ένα δυναμικό σύστημα περιγράφεται είτε με συνάρτηση 
μεταφοράς (Σ.Μ) είτε στο χώρο κατάστασης (Χ.Κ). Το MATLAB περιέχει τις συναρτήσεις tf 
και ss καθώς και τη zpk (Πίνακας 14.1) για τις περιγραφές αυτές. 

Επίσης, το MATLAB επιτρέπει την μετάβαση από το χώρο κατάστασης σε συνάρτηση 
μεταφοράς και αντίστροφα. Επιπλέον, εάν οι μηδενιστές, οι πόλοι και το κέρδος της Σ.Μ 
είναι γνωστά, τότε η Σ.Μ καθώς και ο Χ.Κ μπορούν να υπολογιστούν απευθείας και 
αντίστροφα. Οι απαραίτητες εντολές παρουσιάζονται στον Πίνακα 14.2. 

 

Πίνακας 14.1 
Βασικές Περιγραφές Συνεχών Συστημάτων 

sys=tf(num,den) 

sys=ss(A,B,C,D) 

sys=zpk(Z,P,K) 

Συνάρτηση Μεταφοράς 

Χώρος Κατάστασης 

Μηδενιστές-Πόλοι-Κέρδος Συστήματος 

 
Πίνακας 14.2 

Μετατροπές Περιγραφών Συστημάτων 

[num, den]=ss2tf(A,B,C,D) Χώρος Κατάστασης σε Συνάρτηση Μεταφοράς 

-2 -1.5 -1 -0.5 0 0.5 1 1.5 2
-1

0

1

2

3

4

5

6

7

8
The Witch Curve



 27

[A,B,C,D]=tf2ss(num,den) 

[Z,P,K]=ss2zp(A,B,C,D) 

[Z,P,K]=tf2zp(num,den) 

[num, den]=zp2tf(Z,P,K) 

[A,B,C,D]=zp2ss(Z,P,K) 

Συνάρτηση Μεταφοράς σε Χώρο Κατάστασης 

Χώρος Κατάστασης σε Πόλους-Μηδενιστές-Κέρδος 

Συνάρτηση Μεταφοράς σε Πόλους-Μηδενιστές-Κέρδος 

Πόλοι-Μηδενιστές-Κέρδος σε Συνάρτηση Μεταφοράς 

Πόλοι-Μηδενιστές-Κέρδος σε Χώρο Κατάστασης 

 

Στους πίνακες 14.1 και 14.2, num και den είναι τα πολυώνυμα που ορίζουν τον αριθμητή 
και τον παρονομαστή, αντίστοιχα, της συνάρτησης μεταφοράς του συστήματος. Οι πίνακες 
A,B,C,D είναι οι πίνακες περιγραφής του συστήματος στο χώρο κατάστασης και Z, P είναι τα 
διανύσματα που περιέχουν τους μηδενιστές και τους πόλους του συστήματος και K είναι το 
κέρδος του. 

Παράδειγμα 14.1: Να βρεθεί μια περιγραφή στον Χώρο Κατάστασης του συστήματος που 
έχει συνάρτηση μεταφοράς G(s)=1/(s2+2s+1). 

Οι απαιτούμενες εντολές φαίνονται στο Σχήμα 14.1. 

 
Σχήμα 14.1. Κώδικας για τον υπολογισμό του Χ. Κ. από Σ. Μ. 

 

Για τον υπολογισμό της βηματικής και κρουστικής απόκρισης ενός συστήματος, το MATLAB 
διαθέτει τις εντολές step και impulse αντίστοιχα. Για οποιαδήποτε άλλη αυθαίρετη είσοδο 
χρησιμοποιείται η εντολή lsim. Επίσης, για απόκριση σε αρχικές συνθήκες υπάρχει η εντολή 
initial (σε αυτή την περίπτωση το σύστημα πρέπει να περιγραφεί στον Χ.Κ). Η σύνταξη των 
παραπάνω εντολών παρουσιάζεται στον Πίνακα 14.3. 

 

 

Πίνακας 14.3 
Απόκριση Συνεχών Συστημάτων 

step(sys) 

impulse(sys) 

lsim(sys,u,t) 

initial(sys,x0,t) 

Βηματική απόκριση 

Κρουστική απόκριση 

Απόκριση σε οποιαδήποτε είσοδο 

Απόκριση σε αρχικές συνθήκες (Μόνο για Χ.Κ) 

 

Στον Πίνακα 14.3, sys είναι η περιγραφή του συστήματος στο πεδίο της συχνότητας (Σ.Μ) ή 
στο πεδίο του χρόνου (Χ.Κ) όπως προκύπτει από τον Πίνακα 14.1, t είναι το διάνυσμα του 
χρόνου και u είναι το διάνυσμα της εισόδου (τα διανύσματα t και u πρέπει να έχουν τις ίδιες 
διαστάσεις). Τέλος x0 είναι το διάνυσμα των αρχικών συνθηκών. 

Η εντολή step μπορεί να συνταχθεί και ως step(num,den) ή ισοδύναμα step(A,B,C,D). Το 
ίδιο ισχύει και για τις υπόλοιπες εντολές του Πίνακα 14.3. Επίσης η εντολή step δίνει την 
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απόκριση σε μοναδιαία βηματική είσοδο. Για αποκρίσεις σε βηματικές εισόδους πλάτους α, 
χρησιμοποιείται step(α*sys). 

Παρατήρηση: Για την δημιουργία του σήματος εισόδου στην lsim, πολλές φορές 
χρησιμοποιείται η εντολή: 

[u,t]=gensig(type,tau), 

Όπου type είναι το είδος εισόδου (‘sin’,‘square’, ‘pulse’) και tau είναι η περίοδος του 
σήματος εισόδου. 

 

Παράδειγμα 14.2: Να υπολογιστεί η απόκριση του συστήματος του Παραδείγματος 1 σε 
μοναδιαία αναρριχητική είσοδο. 

Στο Σχήμα 14.2 παρουσιάζονται οι απαιτούμενες εντολές. 

 
 

Σχήμα 14.2. Κώδικας για τον υπολογισμό της αναρριχητικής απόκρισης του συστήματος. 

Η απόκριση ενός συστήματος καθορίζεται από τους πόλους και τους μηδενιστές του. Το 
MATLAB διαθέτει τις εντολές του Πίνακα 14.4 για τον υπολογισμό τους: 

 

Πίνακας 14.4 
Πόλοι – Μηδενιστές 

pole(sys) 

zero(sys) 

pzmap(sys) 

minreal(sys) 

Πόλοι Συστήματος 

Μηδενιστές Συστήματος 

Διάγραμμα Πόλων – Μηδενιστών 

Απαλοιφή Κοινών Πόλων - Μηδενιστών 

 

Παράδειγμα 14.3: Να υπολογιστεί η συνάρτηση μεταφοράς και στην συνέχεια να βρεθούν οι 
πόλοι και οι μηδενιστές καθώς και το διάγραμμα τους για το σύστημα που περιγράφεται 
στον χώρο κατάστασης από τους πίνακες: 
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 A = −3 −2
1 0

⎡

⎣
⎢

⎤

⎦
⎥,B = 1

0

⎡

⎣
⎢

⎤

⎦
⎥ ,C= 1 −1⎡⎣ ⎤⎦,D =0  

 
Σχήμα 14.3. Κώδικας για το Παράδειγμα 3. 

Συνήθως ένα σύστημα αποτελεί μέρος ενός ευρύτερου συνόλου συστημάτων, τα οποία 
συνδέονται μεταξύ τους. Το MATLAB περιέχει συναρτήσεις που δίνουν τη συνάρτηση 
μεταφοράς δύο συστημάτων τα οποία συνδέονται μεταξύ τους σε σειρά, παράλληλα, με 
θετική (ή αρνητική) ανατροφοδότηση. Η σύνταξη αυτών των εντολών παρουσιάζεται στον 
Πίνακα 14.5. 

Πίνακας 14.5 
Σύνδεση Συστημάτων 

sys=series(sys1,sys2) 

sys=parallel(sys1,sys2) 

sys=feedback(sys1,sys2,-1) 

sys=feedback(sys1,sys2,+1) 

Σύνδεση Συστημάτων σε Σειρά 

Σύνδεση Συστημάτων Παράλληλα 

Σύνδεση Συστημάτων με Αρνητική Ανατροφοδότηση 

Σύνδεση Συστημάτων με Θετική Ανατροφοδότηση 

 

Παρατήρηση: Η εντολή sys=feedback(sys1,sys2,-1) είναι ισοδύναμη με την εντολή 
sys=feedback(sys1,sys2). 

Παράδειγμα 14.4: Να υπολογιστεί η συνάρτηση μεταφοράς του συστήματος κλειστού 
βρόχου του Σχήματος 14.4. 
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Σχήμα 14.4. Έλεγχος συστήματος με PI ελεγκτή. 

Στο Σχήμα 14.5, παρουσιάζονται οι απαιτούμενες εντολές για τον υπολογισμό της Σ.Μ του 
συστήματος του Σχήματος 14.4. 

Σχήμα 14.5. Κώδικας για τον υπολογισμό της Σ.Μ του συστήματος του Σχήματος 14.4. 

Για τη μελέτη γραμμικών συστημάτων στο πεδίο της συχνότητας, το Matlab διαθέτει τις 
εντολές που παρουσιάζονται στον Πίνακα 14.6. 

 

Πίνακας 14.6 
Συχνοτική απόκριση 

bode(sys) 
[Gm,Pm,Wcg,Wcp] = margin(sys) 

Διαγράμματα Bode 
Περιθώριο Κέρδους – Περιθώριο Φάσης 
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H=freqresp(sys,w) 
nyquist (sys) 
nichols (sys) 

Συχνοτική απόκριση 
Διαγράμματα nyquist 
Διαγράμματα nichols 

 

Στον Πίνακα 14.6, sys είναι το σύστημα, ορισμένο με κάποια από τις περιγραφές του Πίνακα 
14.1, και w η συχνότητα σε rad/s. Επίσης Gm και Pm είναι τα περιθώρια κέρδους και φάσης 
αντίστοιχα ενώ Wcg και Wcp είναι οι αντίστοιχες συχνότητες. 

 

Παράδειγμα 14.5: Να σχεδιαστούν τα διαγράμματα Bode και Nyquist, για ένα σύστημα που 
έχει πόλους στα σημεία -1 και -5, μηδενιστή στο σημείο 2 και κέρδος K = 3. 

Στο Σχήμα 14.6, παρουσιάζονται οι απαιτούμενες εντολές. 

Σχήμα 14.6. Κώδικας για τον υπολογισμό των διαγραμμάτων Bode και Nyquist 

 

Από τον κώδικα του Σχήματος 14.6 προκύπτουν τα παρακάτω διαγράμματα Bode και 
Nyquist. 

 

Σχήμα 14.7. Διάγραμμα Bode του συστήματος του Παραδείγματος 5. 
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Σχήμα 14.8. Διάγραμμα Nyquist του συστήματος του Παραδείγματος 5. 

 

Ένα από τα εργαλεία που χρησιμοποιείται στην ανάλυση και στην σχεδίαση συστημάτων 
αυτομάτου ελέγχου, είναι η μέθοδος του γεωμετρικού τόπου ριζών (γ.τ.ρ). Το Matlab 
διαθέτει, για τον σκοπό αυτόν, τις εντολές του Πίνακα 14.7. 

 

Πίνακας 14.7 
Γεωμετρικός Τόπος Ριζών 

rlocus(sys) 
[K, poles]=rlocfind(sys,P) 

Διάγραμμα τόπου ριζών 
Υπολογισμός Κέρδους και πόλων 

 

Όπου P είναι το διάνυσμα των επιθυμητών πόλων. 

Παρατήρηση: Η εντολή rlocfind μπορεί να χρησιμοποιηθεί και χωρίς το όρισμα των 
επιθυμητών πόλων P. Σ’ αυτή την περίπτωση η επιλογή του επιθυμητού πόλου γίνεται με 
επιλογή του από το διάγραμμα του γ.τ.ρ. 

Παράδειγμα 14.6: Να υπολογιστεί ο γ.τ.ρ του συστήματος με συνάρτηση μεταφοράς: 

 G(s)= 2

s3 +6 s2 +5s
 

Στην συνέχεια να υπολογιστεί το κέρδος και οι αντίστοιχοι πόλοι για επιθυμητό πόλο κοντά 
στο σημείο – 6. 

Στο Σχήμα 14.9 παρουσιάζονται οι απαιτούμενες εντολές. 
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Σχήμα 14.9. Κώδικας για την σχεδίαση γ.τ.ρ καθώς για τον υπολογισμό του κέρδους. 

Παρακάτω παρουσιάζονται τα αποτελέσματα που δίνει ο κώδικας. 

Σχήμα 14.11. Γεωμετρικός τόπος ριζών για το σύστημα του Παραδείγματος 14.6. 

Σχήμα 14.12. Το κέρδος και οι αντίστοιχοι πόλοι κλειστού βρόχου, για επιθυμητό πόλο -6. 

Όπως τα συνεχή συστήματα, έτσι και τα διακριτά συστήματα περιγράφονται είτε με 
συνάρτηση μεταφοράς (Σ.Μ) είτε στο χώρο κατάστασης (Χ.Κ). Το MATLAB περιέχει τις 
συναρτήσεις tf και ss καθώς και τη zpk (Πίνακας 14.8) για τις περιγραφές αυτές. 

Πίνακας 14.8 

Βασικές Περιγραφές Διακριτών Συστημάτων 

sys=tf(num,den,Ts) 

sys=ss(A,B,C,D,Ts) 

sys=zpk(Z,P,K,Ts) 

Συνάρτηση Μεταφοράς 

Χώρος Κατάστασης 

Μηδενιστές-Πόλοι-Κέρδος Συστήματος 

 

όπου Ts είναι η περίοδος δειγματοληψίας. Αν αυτή δεν ορίζεται τότε θέτουμε Ts = -1. 

Οι αντίστοιχες εντολές για την απόκριση των διακριτών συστημάτων σε διάφορες εισόδους 
παρουσιάζονται στον Πίνακα 14.9. 

Πίνακας 14.9 

Απόκριση Διακριτών Συστημάτων 

dstep(num,den) 

dimpulse(num,den) 

Βηματική απόκριση 

Κρουστική απόκριση 
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dlsim(num,den,u,t) 

dinitial(A,B,C,D,x0,t) 

Απόκριση σε οποιαδήποτε είσοδο 

Απόκριση σε αρχικές συνθήκες (Μόνο για Χ.Κ) 

Παράδειγμα 14.7: Να υπολογιστεί η βηματική απόκριση του διακριτού συστήματος: 

 G z( )= 1

z−0.5
 

Στο Σχήμα 14.13, δίνονται οι απαιτούμενες εντολές: 

Σχήμα 14.13. Εντολές για την βηματική απόκριση διακριτού συστήματος. 

Στον ψηφιακό έλεγχο, πολλές φορές, είναι απαραίτητη η μετατροπή ενός συνεχούς 
συστήματος σε διακριτό (διακριτοποίηση). Για τη διαδικασία αυτή, το Matlab διαθέτει τις 
εντολές του Πίνακα 14.10. 

Πίνακας 14.10 

Διακριτοποίηση συστημάτων. 

sysd = c2d(sys,Ts,'method') 

[Ad,Bd,Cd,Dd] = c2dm(A,B,C,D,Ts,'method') 

[numd,dend] = c2dm(num,den,Ts,'method') 

Συνεχές σε Διακριτό 

Συνεχές σε Διακριτό (Χ. Κ.) 

Συνεχές σε Διακριτό (Σ. Μ.) 

 

Όπου method είναι η μέθοδος διακριτοποίησης (‘zoh’, ‘foh’, ‘imp’, ‘tustin’, ‘prewarp’, 
‘matched’) και Ts είναι η περίοδος δειγματοληψίας. 

Παρατηρήσεις: Όταν παραλείπεται η παράμετρος method, τότε θεωρείται ότι η 
διακριτοποίηση γίνεται με συγκρατητή μηδενικής τάξης (zoh). Η μέθοδος matched 
χρησιμοποιείται μόνο για συστήματα ΜΕΜΕ. Επίσης όταν χρησιμοποιείται η μέθοδος 
prewarp, θα πρέπει να περιλαμβάνεται και η κρίσιμη συχνότητα Wc (rad/s) ως επιπλέον 
όρισμα στις εντολές του Πίνακα 14.8, δηλαδή: 

sysd=c2d(sys,Ts,'prewarp',Wc) 

Όσο αφορά τις εντολές που αναφέρονται σε μετατροπές περιγραφών (Πίνακας 14.2), 
πόλους – μηδενιστές (Πίνακας 14.4), σύνδεση συστημάτων (Πίνακας 14.5), συχνοτική 
απόκριση (Πίνακας 14.6) και γεωμετρικό τόπο ριζών (Πίνακας 14.7), ισχύουν και για τα 
διακριτά συστήματα. Επίσης, στην περίπτωση που το σύστημα έχει προκύψει από 
διακριτοποίηση, τότε για την απόκριση του μπορούν να χρησιμοποιηθούν οι εντολές του 
Πίνακα 14.3. 

Παράδειγμα 14.8: Έστω το συνεχές σύστημα με συνάρτηση μεταφοράς: 

 G s( )= 1

s s+0.5( )  

Για τον έλεγχο του συστήματος έχει προταθεί ο παρακάτω PD ελεγκτής συνεχούς χρόνου: 
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 Gc s( )=0.5+ 2 s  

Να διακριτοποιηθεί ο παραπάνω ελεγκτής με την μέθοδο Tustin, επιλέγοντας περίοδο 
δειγματοληψίας Τ=0.1s  και να σχεδιαστεί η βηματική απόκριση του κλειστού συστήματος. 

Στο Σχήμα 14.14, παρουσιάζεται ο απαιτούμενος κώδικας Matlab: 

Σχήμα 14.14. Κώδικας για την διακριτοποίηση και την απόκριση του κλειστού συστήματος. 

 

Ο κώδικας του Σχήματος 14.14 δίνει την συνάρτηση μεταφοράς του διακριτοποιημένου 
ελεγκτή και την βηματική απόκριση του κλειστού συστήματος: 

Σχήμα 14.15. Συνάρτηση μεταφοράς του διακριτοποιημένου ελεγκτή του Παραδείγματος 
14.8. 
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Σχήμα 14.16. Βηματική απόκριση του κλειστού συστήματος του Παραδείγματος 14.8.

15. SIMULINK 
Το SIMULINK είναι ένα πρόγραμμα μέσα στο MATLAB που επιτρέπει την προσομοίωση 
δυναμικών συστημάτων χρησιμοποιώντας δομικά διαγράμματα (blocks). Τα διαγράμματα 
αυτά παρέχονται από την βιβλιοθήκη του SIMULINK οργανωμένα σε διάφορες κατηγορίες. 
Τοποθετώντας τα διαγράμματα αυτά σε ένα αρχείο και συνδέοντας τα κατάλληλα μπορούμε 
να προσομοιώσουμε οποιοδήποτε σύστημα. Για καλύτερη κατανόηση της λειτουργίας του 
SIMULINK, στην συνέχεια παρουσιάζονται τρία χαρακτηριστικά παραδείγματα. 

 

Παράδειγμα 15.1: Ένα ερευνητικό υποβρύχιο κινείται κάτω από το επίπεδο του ωκεανού και 
παράλληλα σε αυτό. Η ισοδύναμη μάζα του όταν είναι βυθισμένο είναι M=2400kg. Ο 
συντελεστής οπισθέλκουσας είναι B=320kg/s και η δύναμη προώθησης του είναι σταθερή 
ίση με F=1130N. Να σχεδιαστεί η ταχύτητα v(t) του υποβρυχίου ως συνάρτηση του χρόνου 
εάν η αρχική ταχύτητα του είναι v(0)=0 m/s. 

Καταρχήν, το υποβρύχιο μπορεί να μοντελοποιηθεί ως μια μάζα M στην οποία ασκείται η 
δύναμη προώθησης F καθώς και η οπισθέλκουσα δύναμη -Bv(t). Για το σύστημα αυτό ισχύει 
ο δεύτερος νόμος του Newton. Έτσι: 

 
 
v+ B

M
v= F

M
 (15.1) 

Η Εξ. (15.1) είναι μια γραμμική διαφορική εξίσωση πρώτης τάξης, η οποία μπορεί να λυθεί 
αναλυτικά και να μας δώσει την ταχύτητα ως συνάρτηση του χρόνου: 

 v(t)= F
B
(1−e− (B/M )t )  (15.2) 

Στην συνέχεια θα επιλύσουμε την ίδια διαφορική εξίσωση (αριθμητικά όμως) μέσω του 
SIMULINK.  

Εισάγετε simulink στο Command Window  

>>simulink 
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ή εναλλακτικά πατήστε το κουμπί που βρίσκεται στην πάνω μπάρα. Θα εμφανισθεί ένα 
παράθυρο που περιέχει την βιβλιοθήκη του SIMULINK, η οποία περιέχει διάφορες 
κατηγορίες (π.χ. Continuous, Discrete κ.λπ.), όπως δείχνει το Σχήμα 15.1: 
 

 

Σχήμα 15.1. Βιβλιοθήκη του Simulink. 

Επιλέγοντας “File→New→Model” ανοίγει ένα νέο κενό αρχείο με το όνομα untitled στο 
οποίο θα δημιουργηθεί το σύστημα. 
Πατώντας μια φορά σε οποιοδήποτε κατηγορία, μια λίστα από διαγράμματα (blocks) θα 
εμφανισθεί σε ξεχωριστό παράθυρο. Αυτά τα διαγράμματα μπορούν να εισαχθούν στο 
αρχείο untitled όπου θα πραγματοποιηθεί η προσομοίωση. Η εισαγωγή τους μπορεί να γίνει 
είτε με αντιγραφή – επικόλληση είτε με απλό σύρσιμο τους στο αρχείο. Στο Σχήμα 15.2 
φαίνονται τα blocks που αντιστοιχούν στην κατηγορία Continuous μαζί με το αρχείο 
untitled. 
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Σχήμα 15.2. Αντιπροσωπευτικά διαγράμματα και αρχείο προσομοίωσης. 

Στον Πίνακα 15.1 παρουσιάζονται μερικά βασικά διαγράμματα τα οποία θα 
χρησιμοποιηθούν στα επόμενα παραδείγματα. 

 

Πίνακας 15.1 

Κατηγορία Continuous 

 Όνομα Σχήμα Λειτουργία 

Transfer Function 

 

Περιγραφή Συστήματος με 

Συνάρτηση Μεταφοράς 

State Space 

 

Περιγραφή Συστήματος 

στον Χώρο Κατάστασης 

Integrator 

 

Ολοκλήρωση Σήματος 

Εισόδου 

Derivative 

 

Παραγώγιση Σήματος 

Εισόδου 

Κατηγορία Sources 

 Όνομα Σχήμα Λειτουργία 

Step 

 

Βηματική Είσοδος 
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Ramp 

 

Αναρριχητική Είσοδος 

Clock 

 

Εισαγωγή Χρόνου 

Προσομοίωσης 

Κατηγορία Sinks 

 Όνομα Σχήμα Λειτουργία 

Scope 

 

Απεικόνιση του Σήματος 

Εισόδου Συναρτήσει του 

Χρόνου 

To Workspace 

 

Αποθήκευση Τιμών του 

Σήματος Εισόδου στον 

Χώρο Εργασίας 

Κατηγορία Math operations 

 Όνομα Σχήμα Λειτουργία 

Gain 

 

Πολλαπλασιασμός 

Σήματος Εισόδου με μια 

Σταθερά 

Sum 

 
Άθροιση Σημάτων Εισόδου 

 

Στο παράδειγμα αυτό, η ταχύτητα του υποβρυχίου είναι η μεταβλητή εξόδου και η 
προωθητική δύναμη είναι η μεταβλητή εισόδου. Η συνάρτηση μεταφοράς του συστήματος 
μπορεί να υπολογιστεί από την διαφορική εξίσωση (15.1) χρησιμοποιώντας τις ιδιότητες του 
μετασχηματισμού Laplace. Έτσι: 

 G(s)= v(s)
F(s)

= 1

Ms+B
 (15.3) 

Και εφόσον η δύναμη F είναι σταθερή ξεκινώντας από t=0 s, μπορεί να θεωρηθεί ως 
βηματική είσοδος: 

 F(s)= F
s

 (15.4) 

Για την προσομοίωση του συστήματος επιλέγονται και εισάγονται στο untitled αρχείο τα 
παρακάτω διαγράμματα: 

Α) Από την κατηγορία Sources επιλέγουμε τα διαγράμματα Step και Clock. Το διάγραμμα 
Step αντιπροσωπεύει την σταθερή (βηματική) δύναμη προώθησης. Ενώ το διάγραμμα 
Clock εισάγει τον χρόνο προσομοίωσης. 
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Σχήμα 15.3. Τα διαγράμματα Step και Clock. 

Β) Από την κατηγορία Sinks επιλέγονται τα διαγράμματα Scope και To Workspace. Το 
Scope επιτρέπει την καταγραφή της μεταβολής της εξόδου συναρτήσει του χρόνου ενώ το 
διάγραμμα To Workspace αποθηκεύει τις τιμές της εξόδου σε ένα διάνυσμα με το όνομα 
simout στον χώρο εργασίας (workspace) του MATLAB και το οποίο μπορεί να 
χρησιμοποιηθεί για περαιτέρω ανάλυση. 

 

Σχήμα 15.4. Τα διαγράμματα Scope και To Workspace. 

Γ) Από την κατηγορία Continuous επιλέγετε το διάγραμμα Transfer Fcn. Αυτό επιτρέπει 
την εισαγωγή της συνάρτησης μεταφοράς που υπολογίσθηκε προηγουμένως. 

 

Σχήμα 15.5. Το διάγραμμα Transfer Fcn. 

Όπως προαναφέρθηκε, τα διαγράμματα αυτά μπορούν να μεταφερθούν στο αρχείο είτε με 
αντιγραφή – επικόλληση είτε με σύρσιμο τους από την βιβλιοθήκη στο αρχείο. Με τον τρόπο 
αυτό προκύπτει το ακόλουθο αρχείο. 

 

 

Σχήμα 15.6. Τα απαιτούμενα διαγράμματα συγκεντρωμένα στο αρχείο untitled. 
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Έπειτα, ενώνουμε τα διαγράμματα Step και Transfer Fcn. Αυτό γίνεται με σύρσιμο από το 
βελάκι εξόδου (>) του Step και κατάληξη στο βελάκι εισόδου (>) του Transfer Fcn. Εάν η 
σύνδεση είναι επιτυχής, θα σχηματιστεί ένα μαύρο βέλος που ενώνει τα δυο αυτά 
διαγράμματα όπως φαίνεται στο Σχήμα 15.7. 

 

Σχήμα 15.7. Σύνδεση των διαγράμματα Step και Transfer Fcn. 

Με τον ίδιο τρόπο συνδέονται και τα υπόλοιπα διαγράμματα σύμφωνα με το Σχήμα 15.8. 

Αξίζει να σημειωθεί ότι η σύνδεση του διαγράμματος Scope, γίνεται με σύρσιμο από το 
βελάκι εισόδου (>) του Scope και κατάληξη στο βέλος που συνδέει τα διαγράμματα 
Transfer Fcn και To Workspace. 

 

Σχήμα 15.8. Σύνδεση και των υπόλοιπων διαγραμμάτων. 

Έπειτα, με αντιγραφή – επικόλληση του διαγράμματος To Workspace στο αρχείο, 
δημιουργούμε το διάγραμμα To Workspace1 το οποίο συνδέεται με το διάγραμμα Clock. 
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Σχήμα 15.9. Δημιουργία του διαγράμματος To Workspace1 και σύνδεση του με το 
διάγραμμα Clock. 

Τώρα πρέπει να εισαχθούν στα διαγράμματα οι κατάλληλες παράμετροι που αντιστοιχούν 
στο υποβρύχιο. Πατώντας δύο φορές πάνω στο διάγραμμα Step αλλάζουμε την παράμετρο 
Step time: σε 0 και την παράμετρο Final value: σε 1130 και πατάμε OK. 

 

 

Σχήμα 15.10. Εισαγωγή παραμέτρων του διαγράμματος Step. 

Με τον ίδιο τρόπο στο διάγραμμα Transfer Fcn αλλάζουμε την παράμετρο Denominator: 
βάζοντας [2400 320] και πατάμε Apply και μετά OK. 
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Σχήμα 15.11. Εισαγωγή παραμέτρων του διαγράμματος Transfer Fcn. 

Στο διάγραμμα To Workspace αλλάζουμε τη παράμετρο Variable name: σε v (αντίστοιχα 
του To Workspace1 σε t) και την παράμετρο Save format σε Array και πατάμε Apply και 
μετά OK. Έτσι, οι τιμές της ταχύτητας αποθηκεύονται σε ένα διάνυσμα με το όνομα v και του 
χρόνου σε ένα αντίστοιχο με το όνομα t. 

 

Σχήμα 15.12. Εισαγωγή παραμέτρων του διαγράμματος To Workspace. 
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Επίσης, μπορούμε να αλλάξουμε και τις ετικέτες των διαγραμμάτων. Πατώντας, λοιπόν, μια 
φορά στη λέξη “To Workspace” την αλλάζουμε σε “Velocity”. Ομοίως, αλλάζουμε το “To 
Workspace1” σε “Time”. Τελικά θα προκύψει το αρχείο του Σχήματος 15.13: 

 

 

Σχήμα 15.13. Τελική μορφή του αρχείου. 

Προτού ξεκινήσει η προσομοίωση, θα πρέπει να οριστούν οι παράμετροι της (π.χ. χρόνος 
προσομοίωσης, μέθοδος ολοκλήρωσης, βήμα ολοκλήρωσης κ.λπ.). Αυτές επιλέγονται 
πατώντας “Simulation → Configuration Parameters” όπως φαίνεται και στο Σχήμα 15.14. 

 

Σχήμα 15.14. Εισαγωγή παραμέτρων προσομοίωσης. 
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Για το παράδειγμα μας, αλλάζουμε την παράμετρο Stop Time: σε 40, την Max Step Size: 
σε 1.5 και μετά πατάμε Apply και OK. Τις περισσότερες φορές ο αλγόριθμος επίλυσης των 
διαφορικών εξισώσεων του μοντέλου (solver), ode45 είναι ο πιο κατάλληλος. Σε άλλη 
περίπτωση (π.χ. stiff problems) πρέπει να επιλεχθεί διαφορετικός αλγόριθμος επίλυσης 
(π.χ. ode15s). Για την έναρξη της προσομοίωσης επιλέγουμε Simulation και μετά Start (ή 
εναλλακτικά πατάμε το κουμπί play). Μετά το πέρας της προσομοίωσης πατώντας δυο 
φορές το διάγραμμα Scope, λαμβάνουμε την ταχύτητα του υποβρυχίου συναρτήσει του 
χρόνου όπως φαίνεται στο Σχήμα 15.15. Το ίδιο αποτέλεσμα θα λάβουμε, Σχήμα 15.16, εάν 
εισάγουμε την εντολή plot(t,v) στο Command Window. 

 

Σχήμα 15.15. Η απόκριση της ταχύτητας όπως φαίνεται από το διάγραμμα Scope. 

 

Σχήμα 15.16. Η απόκριση της ταχύτητας όπως προκύπτει από την εντολή plot. 

Για να αποθηκεύσουμε το αρχείο πατάμε File και μετά Save As... και πληκτρολογούμε το 
όνομα του αρχείου (π.χ. submarine) αντί του untitled. 

Παρατήρηση: Οι τιμές των παραμέτρων προσομοίωσης δεν επιλέχθηκαν αυθαίρετα αλλά 
με βάση έναν γενικό κανόνα που ισχύει για τα συστήματα πρώτης τάξης. Έτσι, η 
παράμετρος Stop Time:επιλέχθηκε ίση με πέντε σταθερές χρόνου και η παράμετρος Max 
Step Size: επιλέχθηκε ίση με το ένα-πέμπτο της σταθεράς χρόνου. Η σταθερά χρόνου του 
υποβρυχίου ισούται με τ=M/B=7.5 s. 

Παράδειγμα 15.2: Να λυθεί το Παράδειγμα 1 για την περίπτωση που η αρχική ταχύτητα του 
υποβρυχίου είναι v(0)=2 m/s. 

Η μεθοδολογία που αναπτύχθηκε προηγουμένως βασίστηκε στην συνάρτηση μεταφοράς 
του συστήματος. Όπως είναι γνωστό, όμως, η συνάρτηση μεταφοράς ορίζεται για μηδενικές 
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αρχικές συνθήκες. Στην συνέχεια θα δείξουμε πως επιλύεται αριθμητικά, μέσω Simulink, μια 
γραμμική διαφορική εξίσωση με μη μηδενικές αρχικές συνθήκες. 

Η Eξ. (1) μπορεί να γραφεί ως: 

 
 
v=− B

M
v+ F

M
 (15.5) 

Για την επίλυση της Εξ. (15.5) στο Simulink απαιτούνται τα παρακάτω διαγράμματα: 

Α) Από την κατηγορία Continuous επιλέγουμε τo διάγραμμα Integrator. Το διάγραμμα αυτό 
χρησιμοποιείται για την ολοκλήρωση ενός σήματος. Στην περίπτωση μας χρησιμοποιείται 
για τη δημιουργία της ταχύτητας v από την επιτάχυνση  v . 

 

Σχήμα 15.17. Το διάγραμμα Integrator. 

Β) Από την κατηγορία Math operations επιλέγονται τα διαγράμματα Gain και Sum. Το 
διάγραμμα Gain πολλαπλασιάζει την είσοδο του με μια σταθερά. Η είσοδος μπορεί να είναι 
βαθμωτό ή διανυσματικό σήμα και η τιμή της σταθεράς μπορεί να είναι βαθμωτή ή 
διανυσματική. Εδώ χρησιμοποιείται για τον σχηματισμό των συντελεστών της εξίσωσης. Το 
διάγραμμα Sum χρησιμοποιείται για άθροιση σημάτων. 

 

Σχήμα 15.18. Τα διαγράμματα Gain και Sum. 

Γ) Επίσης τα διαγράμματα Step και Scope που χρησιμοποιηθήκαν στο Παράδειγμα 15.1. 

Εισάγουμε τα παραπάνω διαγράμματα σε ένα νέο αρχείο, οπότε προκύπτει το Σχήμα 15.19. 

 

Σχήμα 15.19. Το αρχείο με τα απαιτούμενα διαγράμματα. 



 47

Τώρα πρέπει να εισαχθούν στα διαγράμματα οι κατάλληλες παράμετροι που αντιστοιχούν 
στη διαφορική εξίσωση. Πατώντας δύο φορές πάνω στο διάγραμμα Gain αλλάζουμε την 
παράμετρο Gain: σε 1/M ενώ η παράμετρος Multiplication: παραμένει σε Element-wise 
(K.*u). Αντίστοιχα στο διάγραμμα Gain1 αλλάζουμε την παράμετρο Gain: σε B/M. Τέλος 
πατάμε Apply και μετά OK. 

Προσοχή: Οι μεταβλητές B και M, θα πρέπει να έχουν ορισθεί πριν την προσομοίωση 
διαφορετικά θα πρέπει να εισαχθούν στα διαγράμματα οι αντίστοιχες αριθμητικές τους τιμές. 

 

Σχήμα 15.20. Εισαγωγή παραμέτρων του διαγράμματος Gain. 

Πατώντας δύο φορές πάνω στο διάγραμμα Sum αλλάζουμε την παράμετρο List of signs: 
σε +- και πατάμε Apply και μετά OK. 

 

Σχήμα 15.21. Εισαγωγή παραμέτρων του διαγράμματος Sum. 

Οι αρχικές συνθήκες του συστήματος εισάγονται μέσω του διαγράμματος Integrator. Έτσι 
πατώντας δύο φορές πάνω του, αλλάζουμε την παράμετρο Initial condition: σε 2 και 
πατάμε Apply και μετά OK. 
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Σχήμα 22. Εισαγωγή παραμέτρων του διαγράμματος Integrator. 

Στο παράδειγμα 15.1, χρησιμοποιήθηκε το διάγραμμα To Workspace για την αποθήκευση 
των τιμών του χρόνου t και της ταχύτητας v στον χώρο εργασίας και την μετέπειτα χρήση 
τους. Το ίδιο μπορεί και να γίνει μέσω του διαγράμματος Scope. 

Αρχικά πατώντας μια φορά στο διάγραμμα Scope προκύπτει: 

 

Σχήμα 15.23. Αποθήκευση μεταβλητών μέσω του διαγράμματος Scope. 

Έπειτα πατάμε το κουμπί Parameters όπως δείχνει το Σχήμα 15.23. Προκύπτει: 
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Σχήμα 15.24. Αποθήκευση μεταβλητών μέσω του διαγράμματος Scope. 

Επιλέγοντας Data History και στη συνέχεια Save data to workspace αλλάζουμε τη 
μεταβλητή Variable name: σε velocity τη μεταβλητή Format: σε Array. Στην πρώτη στήλη 
του πίνακα με το όνομα velocity θα αποθηκευτούν οι τιμές του χρόνου προσομοίωσης και 
στις υπόλοιπες οι τιμές των εισόδων του διαγράμματος Scope (εδώ της ταχύτητας). 

Επίσης αποεπιλέγουμε το Limit data points to last:, για να μην υπάρχει περιορισμός στο 
πλήθος των τιμών των μεταβλητών που μπορούν να αποθηκευτούν, όπως φαίνεται στο 
Σχήμα 15.25. 

 

Σχήμα 15.25. Αποθήκευση μεταβλητών μέσω του διαγράμματος Scope. 

Στην συνέχεια συνδέουμε τα διαγράμματα όπως φαίνεται στο Σχήμα 15.26. Η αναστροφή 
του διαγράμματος Gain1 έγινε πατώντας δεξί κλικ στο Gain1 και επιλέγοντας 
“Format→Flip Block”. 

Παρατηρήστε ότι το σήμα εξόδου του αθροιστή (διάγραμμα Sum), δίνει την επιτάχυνση 
όπως προκύπτει από την Εξ. (15.5). 
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Σχήμα 15.26. Τελική μορφή του αρχείου. 

Επιλέγοντας όπως και στο παράδειγμα 15.1 τις παραμέτρους επίλυσης και τρέχοντας το 
αρχείο προκύπτει η απόκριση της ταχύτητας του υποβρυχίου: 

 

Σχήμα 15.27. Η απόκριση της ταχύτητας όπως φαίνεται από το διάγραμμα Scope. 

Μέσω του διαγράμματος Scope, έχουν αποθηκευτεί οι τιμές του χρόνου και της ταχύτητας 
σε έναν πίνακα με το όνομα velocity. Η πρώτη στήλη του πίνακα περιέχει τις τιμές του 
χρόνου t ενώ η δεύτερη στήλη περιέχει τις τιμές της ταχύτητας v. 

Έτσι πληκτρολογώντας στο Command Window: 

>> t=velocity(:,1); 

>> v=velocity(:,2); 

>> plot(t,v) 

Προκύπτει: 
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Σχήμα 15.28α. Η απόκριση της ταχύτητας όπως προκύπτει από την εντολή plot. 

Στο σημείο αυτό θα πρέπει να αναφερθεί πως σε ένα αρχείο Word, η απόκριση δεν 
εισάγεται με τη μορφή που έχει στο Σχήμα 15.28α αλλά ως κάποιο αρχείο JPEG, Bitmap, 
Eps κ.λπ. όπως φαίνεται στο Σχήμα 15.28β. Η διαδικασία εισαγωγής εικόνας σε αρχείο word 
παρουσιάζεται στο Παράρτημα Α. 

 

Σχήμα 15.28β. Η απόκριση της ταχύτητας σε μορφή Eps. 

Παράδειγμα 15.3: Να λυθεί το Παράδειγμα 15.1 για την περίπτωση που η οπισθέλκουσα 
δύναμη είναι της μορφής −Bv2 και η αρχική ταχύτητα του υποβρυχίου είναι v(0)=2 m/s. 

Στην περίπτωση αυτή, η εξίσωση κίνησης του υποβρυχίου είναι: 

 
 
v+ B

M
v2 = F

M
 (15.6) 

Η Εξ. (15.6) είναι μη γραμμική διαφορική εξίσωση. Στην συνέχεια, θα παρουσιαστεί ένας 
τρόπος αριθμητική της επίλυσης μέσω του Simulink. 

Θα χρησιμοποιηθούν τα παρακάτω διαγράμματα: 
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Α) Από την κατηγορία User-defined-functions επιλέγουμε το διάγραμμα MATLAB Fcn. Το 
διάγραμμα αυτό εφαρμόζει μια συνάρτηση χρησιμοποιώντας κώδικα Matlab. Μπορεί να 
δεχτεί διανυσματικές εισόδους και να δώσει αντίστοιχα διανυσματικές εξόδους. 

 

Σχήμα 15.29. Το διάγραμμα MATLAB Fcn. 

Β) Από την κατηγορία Signal Routing επιλέγουμε το διάγραμμα Mux. Το διάγραμμα αυτό 
συνδυάζει δύο ή περισσότερα βαθμωτά ή/και διανυσματικά σήματα εισόδου. Σαν έξοδο δίνει 
ένα διανυσματικό σήμα που περιέχει τα σήματα εισόδου. 

 

Σχήμα 15.30. Το διάγραμμα Mux. 

Γ) Επίσης επιλέγονται και τα διαγράμματα Step, Scope και Integrator που 
χρησιμοποιήθηκαν και στο Παράδειγμα 15.2. 

Εισάγουμε τα παραπάνω διαγράμματα σε ένα νέο αρχείο, οπότε προκύπτει το Σχήμα 15.31. 

 

Σχήμα 15.31. Το αρχείο με τα απαιτούμενα διαγράμματα. 

Τώρα πρέπει να εισαχθούν στα διαγράμματα οι κατάλληλες παράμετροι. Για τα διαγράμματα 
Step, Integrator και Scope ισχύουν οι παράμετροι του Παραδείγματος 15.2. Πατώντας δύο 
φορές πάνω στο διάγραμμα MATLAB Fcn αλλάζουμε την παράμετρο MATLAB Fcn: σε 
submarine_motion(u(1:2)). Το submarine_motion είναι το όνομα του function αρχείου που 
δίνει τη μη γραμμική διαφορική εξίσωση (βλέπε Σχήμα 15.33). Η δημιουργία τέτοιων 
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αρχείων έχει αναφερθεί στο Κεφ. 13. Η μεταβλητή u(1:2) δίνει το όνομα και το πλήθος των 
εισόδων που δέχεται το διάγραμμα MATLAB Fcn (στο παράδειγμα αυτό είναι η προωθητική 
δύναμη F  και η ταχύτητα v  του υποβρυχίου). Επίσης, αλλάζουμε την παράμετρο Output 
Dimensions: σε 1 που αντιστοιχεί στο πλήθος των εξόδων του διαγράμματος MATLAB Fcn 
(στο παράδειγμα αυτό είναι η επιτάχυνση  v  του υποβρυχίου). Τέλος πατάμε Apply και μετά 
OK. 

 

Σχήμα 15.32. Εισαγωγή παραμέτρων του διαγράμματος MATLAB Fcn. 

 

Σχήμα 15.33. Αρχείο function που χρησιμοποιείται στο διάγραμμα MATLAB Fcn. 

Στην συνέχεια συνδέουμε τα διαγράμματα όπως φαίνεται στο Σχήμα 15.34. 
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Σχήμα 15.34. Τελική μορφή του αρχείου. 

Επιλέγοντας όπως και στο παράδειγμα 15.1 τις παραμέτρους επίλυσης και τρέχοντας το 
αρχείο προκύπτει η απόκριση της ταχύτητας του υποβρυχίου: 

 

Σχήμα 15.35. Η απόκριση της ταχύτητας όπως φαίνεται από το διάγραμμα Scope. 

Στα παραπάνω παραδείγματα προσομοιώσαμε την απόκριση ενός συστήματος (γραμμικού 
και μη γραμμικού) με ή χωρίς αρχικές συνθήκες σε μια βηματική είσοδο. Στα συστήματα 
αυτομάτου ελέγχου, η συμπεριφορά ενός τέτοιου συστήματος ελέγχεται από έναν ελεγκτή. Ο 
ελεγκτής συνδέεται με το προς έλεγχο σύστημα και μπορεί να είναι είτε συνεχούς χρόνου 
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είτε διακριτού. Στο Παράδειγμα 15.4 παρουσιάζεται η σύνδεση ενός PI ελεγκτή με το προς 
έλεγχο σύστημα μέσω του Simulink. 

Παράδειγμα 15.4: Να γίνει έλεγχος, μέσω του Simulink, του συστήματος του υποβρυχίου με 
συνάρτηση μεταφοράς που δίνεται από την Εξ. (15.3), με έναν PI ελεγκτή που έχει κέρδη: 

 kP =160, kI =240  

και να παρουσιαστούν γραφικά η απόκριση της ταχύτητας για επιθυμητή τιμή αναφοράς v=1 
m/s καθώς και ο νόμος ελέγχου που προκύπτει από τον ελεγκτή. 

Στο Σχήμα 15.36 δίνεται η δομή του συστήματος κλειστού βρόχου. 

Σχήμα 15.36. Έλεγχος του υποβρυχίου με PI ελεγκτή. 

όπου στο διάγραμμα Step εισάγεται η επιθυμητή τιμή της ταχύτητας, σύμφωνα με το Σχήμα 
15.10 και στα διαγράμματα Gain και Gain1 εισάγονται οι αντίστοιχες τιμές των κερδών kP  
και kI  του ελεγκτή σύμφωνα με το Σχήμα 15.20. 

Από το διάγραμμα Scope προκύπτει η απόκριση της ταχύτητας όπως φαίνεται στο Σχήμα 
15.37, ενώ ο νόμος ελέγχου προκύπτει από το διάγραμμα Scope1 και παρουσιάζεται στο 
Σχήμα 15.38. 

Σχήμα 15.37. Απόκριση ταχύτητας υποβρυχίου μετά τον έλεγχο. 
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Σχήμα 15.38. Νόμος έλεγχου PI ελεγκτή. 
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Παράρτημα Α 
Εισαγωγή εικόνας σε αρχείο word 

Επιλέγουμε από το Figure 1 του Σχήματος 15.28α: 

“File → Export Setup → Επιλέγουμε επιθυμητά χαρακτηριστικά για Size, Rendering, 
Fonts και Lines → Export → Επιλογή είδους (Eps,JPEG κ.λπ.) και ονομασίας αρχείου 
→Save → OK”. 

Στην συνέχεια στο αρχείο Word εκτελούμε: 

“Εισαγωγή → Εικόνα από αρχείο → Επιλέγουμε το επιθυμητό αρχείο” και προκύπτει 
το Σχήμα 15.28β. 
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